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Welcome to Metrix 22.1 

ePS Metrix is an industry-leading job planning engine that transforms big data into actionable data in the most 
proven end-to-end integrated solution with a holistic view into manufacturing. With over 1,200 Metrix users in 25 
countries and 17 years of continuous, aggressive development, Metrix is recognized as the de facto industry 
standard for dynamic, intelligent production planning, and automated imposition. 

The Complete Planning and Imposition Solution 

The ePS Metrix solution stores your presses, finishing equipment, stock, folds, users’ logins and permissions, 
along with your manufacturing standards. Centralizing this information ensures uniformity, efficiency, and 
ultimately error-free planning and imposition across your entire organization. The ePS Metrix solution 
automatically and dynamically determines how many press sheets you need, the optimum layout for each press 
sheet, and even figures out for you the most cost-effective printing method, press, and sheet size. 

About this Guide

Metrix comes in four major versions: Standalone, Commercial-Suite-Integrated (Monarch), Packaging-Suite-
Integrated (Radius), and Midmarket-Suite-Integrated (Pace . This guide covers the first two only. If you have 

one of the other versions of this product, please see the documentation for your version of the product. 

After you install Metrix, please consult the ePS Metrix User Guide for information on using the software. 

Notes Request these documents from Metrix Sales or Support (contact information is on page 5). 

Metrix 22.1 

Metrix Base may include any of the following modules:  

• Auto Plan (optional) 

• Capacity Plus (optional) 

• N-Up Binding (optional) 

• Barcodes (included) 

• Automation Pro (optional) 

• Automation Lite (optional) 

• Content Previews (included) 

• Irregular Shapes (optional) 

• Media Optimization (included) 

• Display Graphics (included) 
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Contact Information 

ePS Support 

Web Site: communities.efi.com 

US Phone: 1.855.EFI.4HLP (1.855.334.4457) 

UK Phone: +44 (0) 800.783.2737 

EU Phone: +49.2102.745.4500     

E-Mail: metrix.support@efi.com  

Metrix Support hours are 8AM CET to 5pm ET Monday – Friday.  You may contact support at the above 
numbers or via our customer portal at communities.efi.com. 

Note For problems involving infrastructure (e.g., computers, networks, operating systems, backup software, 
printers, third-party software, etc.), contact the appropriate vendor. ePS cannot support these types of 
issues. 

ePS Professional Services 

US Phone: (651) 365-5321 

US Fax: (651) 365-5334 

E-Mail: ProfessionalServicesOperations@efi.com 

Note ePS Professional Services can help you perform ePS software installations, upgrades, and updates. 
This group can also help you implement, customize, and optimize your ePS software plus offer a range 
of training options. 

 

  

mailto:metrix.support@efi.com
https://communities.efi.com/
mailto:ProfessionalServicesOperations@efi.com
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Metrix Base – Key Features 

• Maximum sheet dimension (W and H): 984.25” (25,000mm) 

• Maximum products handled by Auto Layout: 16 

• Maximum products per project: 100 

Feature Included or optional 

Plans/imposes flat, folded, bound, and die-cut jobs Included 

Automatically determines the most cost-effective Production 
Method, Press, and Sheet Size (Auto Production) 

Included 

Automatically matches new layouts to saved profiles (Standards) Included 

User Permissions, Logins, and Passwords Included 

Handles chop cuts automatically (Auto Bleed) Included 

Prints reports Included 

Imports JDF Included 

Imports Metrix XML and CSV data Included 

Exports Imposed PDF  Included 

Exports Metrix XML Included 

Exports JDF Imposition/JDF Stripping Included 

Exports JDF/CIP 3 Cutting data Included 

Exports JDF/CIP Folding data Included 

Exports JDF Binding data Included 

Site Licenses Included 

JDF Color Mapping Included 

Roll-fed presses Included 

Stock support Included 

Run List Included 

Auto Expand/Contract Trims Included 

Super Wide Format  Included 

Media Optimization module Included 

Display Graphics module Included 

Content Previews Included 

Barcodes module Included 

Auto Plan module Optional 

Capacity Plus module Optional 

N-Up Binding module Optional 

Automation Pro module Optional 

Automation Lite module Optional 

Irregular Shapes module Optional 
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Auto Plan Module 

• Automatically and dynamically determines how many layouts are required for the products in the 
project. 

• Plans and simultaneously imposes across multiple press sheets and even multiple presses. 

• Uses real costing data from the Metrix database. 

• Applies standards where appropriate. 

• Uses proprietary and sophisticated algorithms to consider dozens, hundreds, or even thousands of 
options to find the most cost-effective project solution. 

Capacity Plus Module 

• Allows for projects of greater complexity – more products for Auto Layout and Auto Production 
calculations and more products per project. 

• Up to 2,000 products allowed per project, regardless of the number of press sheets. 

• Up to 200 products allowed for Auto Production and Auto Layout calculations. 

N-Up Binding Module 

• Automates setup of products that print, fold, and bind 2- or 3-up on a press sheet. 

• Provides visual feedback on how the project will fit on a press sheet with the new manufacturing 
configuration. 

Note Metrix compensates for shingling/creep. 

Automation Pro / Automation Lite Modules 

Automation Pro and Automation Lite are advanced hot-folder driven modules for Metrix that accept MXML, CSV, 
JDF Stripping, or JDF Intent files and fully automate their processing in Metrix. “Automation mode” (available in 
the File menu) switches Metrix to the Automation User Interface that enables many projects to flow through 
Metrix with no operator involvement. 

• When MXML files arrive in the Automation Hot Folder, the system: 

• Creates a Metrix project. 

• Applies settings. 

• Performs tasks. 

• Exports output files (JDF, PDF, etc.) automatically. 

• Commands can come from two places:  

• Loaded from one of several Commands files. 

• Embedded in the incoming MXML data (Pro only). 

Note Automation Lite functions like Automation Pro with two differences:  
(1) Automation Lite does not allow you to embed scripting commands in incoming MXML 
files. 
(2) There is no requirement to maintain a Maintenance Service Agreement (MSA). 

Non-rectangular Shapes Module 

• Ability to nest non-rectangular shapes without needing a die-cutting tool or multi-up die standard.  

• Die-cutting tools and multi-up die standards use the geometry of customer-supplied multi-up dies. 

• Plans projects that contain a mix of die-cut and other types of products. 
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Note Metrix plans die-cut products to a separate layout from other types of products. 

Platform and Licensing 

Metrix features and functionality are identical on Windows and Mac OS. You can mix and match in a multi-user 
environment. eFlow licensing works on either platform. 

License Types 

Metrix 22.1 uses eFlow License Manager, a web-based license server that replaces dongle-based licensing. The 
two license types are:  

• Concurrent User License: This replaces the Network License, which allowed multiple installations of 
Metrix to use the same License Server and dongle. The Concurrent User License is managed by eFlow 
and can be shared by multiple users who can also share the same database via the Database Server. 

• Single User License: This replaces the Local Machine License, which applies to only one installation 
of Metrix. The Single User License is also managed by eFlow. It can be used by only one installation of 
Metrix at a time and requires using an embedded database. 

Metrix Multi-User Deployment 

Multiple instances of Metrix on Windows and/or Mac OS can share a single eFlow license key via the eFlow 
License Manager, which serves the license to Metrix clients on the network. 

This installation is called Concurrent User Licensed Metrix. The Metrix Data Server can be either on the same 
computer as the eFlow License Manager or on a different one. 

Note Metrix clients are full installations of the software, where the processing occurs locally, that share data 
through the Metrix Data Server. 

eFlow License Manager 

Important Metrix 22.1 requires eFlow LIM version 10.0.10056.39 or newer. This version is compatible with 
Mac OS 12 and Windows 11. The installers and documentation can be downloaded from 
.https://www.efi.com/marketing/productivity-software/downloads/metrix-installers/. 

About the eFlow License Manager  

ePS eFlow License Manager (LIM) is used for licensing ePS components. This is for components that 
do not need the full capabilities of the main eFlow product.    

After you install the eFlow LIM, you can then apply the license for your ePS component using a license 
key. The installation and licensing process requires an Internet connection.  

Notes If do not have an Internet connection on the machine where you are applying the license, you can 
request a license file from ePS.   
 
If you need to transfer the license to a separate machine after it has already been applied, contact 
ePS Support.   
 
If you need to transfer the eFlow LIM to another server, contact ePS Support as you will not be 
able to reactivate the license for Metrix using the same activation code.    

Licensing Metrix  

Only ePS Metrix can be licensed using the eFlow LIM.   

The eFlow LIM permits you to install Metrix on any number of computers because the License Server 
controls the number of concurrent users running Metrix at any one time. 

Metrix uses three main programs when running this way: 
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• eFlow License Manager The program that controls the number of Metrix clients that can run at 

any one time. eFlow LIM requires a license key to run and must have a static IP address. 

• Metrix Data Server Metrix clients communicate with this program to access the database. The 

Data Server must have a static IP address so the Metrix clients can access the shared database. 

• Metrix The full install of Metrix on any number of computers within a single physical site that have 

network access to the eFlow License Server and the Metrix Data Server. Metrix client installations 
must also have the eFlow License Key to run. 

Note You can install eFlow LIM on the same machine as the Metrix Automation Server.  

About Services  

When eFlow LIM is installed, the EPSI eFlow Service is installed. This service must be left running for your 
license to be active and validated.    

You can verify that the service is running in the eFlow Control Panel.  

 

Install the eFlow License Manager 

Note You must install and run the eFlow License Manager prior to starting Metrix.  

Windows Installation: 

1. Close all open programs. 

2. Click the Efi_eFlow_(Version)_Win_LIM.exe file to launch the installer. 

3. If the User Account Control window appears, click Yes to continue. 

 

 

4. Click the I agree radio button to accept the license agreement, and then click Next.  
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5. Accept the default location of C:\eflow, or select a different location, and then click Next.  

 

6. Click Install in the Pre-Installation Summary window.  
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7. When the installation is complete, click Done to exit the installer.  

 

Windows Upgrade: 

1. Close all open programs. 

2. Close the Control Panel but do not stop the eFlow service. 

3. Click the Efi_eFlow_(Version)_Win_LIM.exe file to launch the installer. 

4. If the User Account Control window appears, click Yes to continue. 
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5. Click the I agree radio button to accept the license agreement, and then click Next. 

 

6. Accept the default location of C:\eflow, or select a different location, and then click Next.  

 

a. If the eFlow LIM control panel is open, the “LIM is still running” window will prompt you to close 
the program.  
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7. Click Install in the Pre-Installation Summary window.  

 

8. When the upgrade is complete, click Done in the Upgrade Complete window and restart your computer. 
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Mac OS Installation: 

1. If you are installing eFlow LIM on Mac OS X 10.15 (Catalina), Mac OS 11 (Big Sur), or Mac OS 12 
(Monterey), then do the following before continuing to step 2.  

Note  If you are installing eFlow LIM on Mac OS X 10.14 (Mojave) or earlier, then start on step 2.  

a. Download  EFI eFlow_(Version)_Mac_LIM.zip (Mac installer).  

b. If the eFlow LIM installer does not automatically unzip, then unzip the eFlow LIM installer while 
it is still in the Downloads folder.  

c. Move the unzipped installer (Efi_eFlow_(Version)_Mac_LIM.dmg) to the desktop.  

2. Click the Efi_eFlow_(Version)_Mac_LIM.dmg file to launch the installer. 

3. If the “eFlowLIM” can’t be opened message appears, click OK. 
  

 

4. Next, right-click, and select Open to launch the installer.  

5. Click Open in the “eFlowLIM” is an application created by The Unarchiver message window.  
 

 

6. Select the lock in the Authentication window.  

https://chilp.it/d62dcde
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7. Enter your Username and Password.  

8. Close all open programs and select Next in the Introduction window.  

9. Click Install in the Pre-Installation Summary window.  

10. When the install is complete, click Done to exit the installer.  

 

Mac OS Upgrade: 

1. Stop the eFlow service and close the eFlow LIM Control Panel. 

2. Click the Efi_eFlow_(Version)_Mac_LIM.dmg file to launch the installer. 
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3. If eFlowLIM” can’t be opened message appears, click OK.  
 

 

4. Next, right-click, and select Open to launch the installer.  

5. Click Open in the “eFlowLIM” is an application created by The Unarchiver message window.  
 

 

6. Select the lock in the Authentication window.  

 

7. Enter your Username and Password.  

8. Close all open programs and select Next in the Introduction window.  

9. If you have not already closed the eFlow LIM Control Panel, do so now. Click Install in the Upgrading 
LIM window. 
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10. When the installation is complete, click Done to exit the installer.  
 

 

11. Launch the eFlow LIM Control Panel.  

12. If the service does not start automatically, click Start to start the eFlow service. 

Windows and Mac OS X Initial Setup: 

1. Click the EFI eFlow icon to launch eFlow License Manager Control Panel. 

 
 

2. Enter the License Key, or eFlow License Key, and your Contact Email address into the appropriate 
fields.  

a. Metrix Support will send your Contact Email address a notification that includes your License 
Key, or eFlow License Key.  
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3. In the Region Detector window, select Yes if you are in a non-European region, and select No if you are 
in a European region. 

 

a. If you select No, the Select an Option window will appear. Click Yes to confirm you are 
installing eFlow in a European region. 

 

4. Verify your License Status and select Show License to open the License Information window. 

 

5. Click the Customer folder and copy your Customer ID number. After you install Metrix you will need 
your Customer ID number to complete the Metrix Initial Setup as described in the section Launch 
Metrix. 
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Installing Metrix 

Note on Upgrading to Metrix 22.1  Metrix 22.1 is a full install only – there is no updater. To upgrade, you 
need to uninstall the previous version of Metrix and then perform a 
complete reinstallation. For instructions on uninstalling a previous version, 
please see Upgrading Metrix. 

Windows installation 

Minimum system requirements on Windows 

• Processor: Intel compatible 

Note  Media Optimization module requires a minimum 8-core CPU (recommended 16 core if the Super 
Wide module is used.  

• Processor Speed: 1 GHz minimum 

• Operating Systems: 

Metrix 22.1 will install only on 64-bit systems. Supported operating system versions include: 

• Microsoft Windows 11.x (64-bit) 

• Microsoft Windows 10.x (64-bit) 

• Microsoft Windows 8.x (64-bit) 

• Microsoft Windows Server 2019 (64-bit) 

• Microsoft Windows Server 2016 (64-bit) 

• Microsoft Windows Server 2012 R2 (64-bit)  

• Microsoft SQL Server 2014 SP3 and SP4 (64-bit) 

• Microsoft SQL Server 2016, 2017, and 2019 

Note  Microsoft has ended support for Windows 7 and Windows Server 2008 effective January 14, 
2020, so Metrix will no longer support these platforms.  We recommend you upgrade your 
system to Metrix current minimum system requirements. 

• Memory:  

Note Metrix installs with memory requirements set to 4 GB for Metrix client and Data Server. If you 
need to change this, you can reduce it to 2 GB. For instructions on how to do this, please 
contact Metrix Support. 

• Metrix client—4 GB RAM 
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• Metrix Data Server—2 GB RAM 

• Metrix Automation Server—8 GB  

• Automation Server Pro – 16 GB RAM (Minimum) to 4 GB RAM per CPU Core (64 GB RAM 
Maximum) 

• Automation Server Enterprise – 64 GB RAM (Minimum) to 4 GB RAM per CPU Core (256 GB RAM 
Maximum) 

• Automation Server with Non-Rectangular module—8 GB RAM (Minimum) and 1 Dual-core 
Processor (Minimum) 

• Automation Server with Display Graphics/Media Optimization/Super Wide Format—16 GB RAM 
(Minimum) (32 GB RAM and 16-core, 32-thread processor or better recommended) 

• eFlow License Manager – 256 MB RAM 

• Monitor Resolution: 1024 X 768 or higher 

• Network (multi-user): Static IP address for the Data Server, eFlow License Manager, and 
Automation Server. Automation Server runs as a service and needs a local administration account.  

Notes If you use the Content Previews module, the minimum RAM requirement for Metrix is 6 GB with 
8 GB or more recommended. 

 The Content Previews module is processor intensive, so a fast multi-core processor is 
recommended. If PDF content is being accessed across a LAN, gigabit network speeds are 
recommended when accessing large content files. 

Pre-installation checklists 

Upgrading to Metrix 22.1 from a previous version 

Be sure to save a backup of your Metrix Data and Marks folders, metrix.properties file, and Metrix Password file 
(.mpw, needed only if you are upgrading from Metrix 2016.2 or earlier) so that you can revert to your previous 
version if necessary. 

Warning  Users upgrading from Metrix 2016.1 or earlier will be required to back up their database, install 
2019.2, and then upgrade the database before they can install 22.1 and upgrade the database 
again.  

Metrix for Windows – Single User License 

Before you begin installing Metrix make sure that: 

• Your Windows computer meets the minimum system requirements. 

• You have your eFlow License Key available (Metrix needs this key to run). 

Metrix for Windows – Concurrent User License 

Before you begin installing Metrix make sure that: 

• Your Windows computer meets the minimum system requirements. 

• The ports required for Metrix to communicate are open (see below). 

• A static IP address is assigned to the computer(s) on which the eFlow License Manager and Data 
Server reside. 

• You have your eFlow License Key available (Metrix needs this key to run). 

Windows communication ports 

For any multi-user installation of Metrix, the following ports must be open: 

 Data Server:  9939 

 eFlow License Manager: 8081 
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 SQL Server: 1433 

 PostgreSQL Server: 5432 

Installing Metrix on the Windows platform 

Before installing, close all applications and restart your computer to clear any files from memory. 

Important You must have Administrator privileges to install Metrix. 

1. Copy the ePS Metrix Installer.exe file to your computer. Exact file names will vary based on the build 
number. 

Note For example, ePS Metrix 202212XXXX.exe. 

2. Double-click ePS Metrix Installer. 

3. If the installer requests permission to install Metrix on your computer, click Yes to begin the installation. 

4. On the welcome screen, click Next. 

 

5. On the License Agreement screen, read the “ePS Software End User License Agreement,” click I 
accept the terms of the license agreement, and then click Next.  

Note Click Print if you want to print a copy of the EULA for your records. 
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6. In the Setup Type screen, select the default Complete (unless you have a reason to choose Custom), 
and then click Next.  

 

7. On the Ready to Install the Program screen, click Install. 
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The Installing EFI Metrix screen will show progress as the software is installed.  

 

8. On the InstallShield Wizard Completed screen, click Finish. 



24 ⚫ Productivity Suite | Installation Guide 

 

 

 

Mac OS installation 

Note  Metrix 22.1 uses a new PDF renderer for creating previews. On Mac OS 11, there were performance 
issues with the old renderer. The new one does not have a negative impact on performance, but the 
quality of the previews may not be as good, especially for text. Contact Metrix Support if this is a 
problem for you; they can provide instructions on how to force Metrix to use the old PDF renderer.  

 

Minimum system requirements 

• Processor: Intel Core 2 Duo 

Note  Media Optimization module requires a minimum 8 core CPU (recommended 16 core if the Super 
Wide module is used.) 

• Processor Speed: 2.8 GHz minimum 

• Operating System: 

• OS 12 (Monterey) (see Note above) 

• OS 11 (Big Sur) (see Note above) 

• OS X 10.15 (Catalina) (see Note below) 

• OS X 10.14 (Mojave) 

• OS X 10.13 (High Sierra) 

• OS X 10.12 (Sierra) 

• OS X 10.11.x (El Capitan) 

• OS X 10.10.x (Yosemite) 

• OS X 10.9.x (Mavericks) 
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Notes Metrix requires Java 11. Metrix installs and uses this version internally, regardless of the 
Java version that is installed on the computer. 

 When Metrix is launched on an unsupported OS, a notice should appear:  
“This operating system is not supported.” 

• Memory:  

Notes Metrix installs with memory requirements set to 4 GB for Metrix client and Data Server. If you 
need to change this, you can reduce it to 2 GB. For instructions on how to do this, contact 
Metrix Support (see page 5 for contact information). 

• Metrix Client – 4 GB RAM 

• Metrix Data Server – 2 GB RAM 

• eFlow License Manager – 256 MB RAM  

• Media Optimization – 16 GB RAM  

• Monitor Resolution: 1024 X 768 or higher 

• Network (multi-user): Static IP address for the Data Server and eFlow License Manager. 

Notes If you will use the Content Previews module, the minimum RAM requirement for Metrix is 6 GB 
with 8 GB or more recommended. 

 The Content Previews module is processor intensive. Thus, we recommend a fast multi-core 
processor. If PDF content is being accessed across a LAN, gigabit network speeds are 
recommended when accessing large content files. 

Installing Metrix in OS X 10.9.x or newer 

Note If you have Mac OS X 10.9.x (Mavericks) or newer, you may receive an alert screen because the 
security settings prohibit the installation of programs unless Apple Inc. identifies them.  

 To work around this:  
1. Right-click (or Control-click) the Metrix Installer icon.  
2. Select Open from the menu to install Metrix without a security alert.  

Pre-installation checklist: 

Upgrading to Metrix 22.1 from a previous version  

If you are upgrading from an earlier version of Metrix, please note that Metrix 22.1 is a full install only – there is 
no updater. To upgrade, you need to uninstall the previous version of Metrix and then perform a complete 
reinstall. After completing the steps in this section, you will be directed to go to Installing Metrix.  

Be sure to read the instructions from the beginning and save a backup of your Metrix Data and Marks folders, 
metrix.properties file, and Metrix password file (.mpw, needed only if you are upgrading from Metrix 2016.2 or 
earlier) so that you can revert to your previous version if necessary. 

Warning Users upgrading from Metrix 2016.1 or earlier will be required to back up their database, install 
2019.2, and then upgrade the database before they can install 22.1 and upgrade the database 
again.  

Metrix for Mac OS  – Single User License 

Before you begin installing Metrix make sure that: 

• Your Mac OS X computer meets the minimum system requirements. 

• You have your eFlow License Key available (Metrix needs this key to run). 

Metrix for Mac OS  – Concurrent User License 

Before you begin installing Metrix make sure: 

• Your Mac OS X computer meets the minimum system requirements. 

• The ports required for Metrix to communicate are open (see below). 
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• Static IP addresses have been assigned to the Data Server and to the eFlow License Server Control 
Panel. 

• You have your eFlow license key available (Metrix needs this key to run). 

Mac OS communication ports 

For any multi-user installation of Metrix, the following ports must be open: 

• Data Server: 9939 

• eFlow License Manager: 8081 

• SQL Server: 1433 

• PostgreSQL Server: 5432 

Installing Metrix on the Mac 

Before installing, we recommend that you close all applications and restart your computer to clear any files from 
memory. 

Important You must have Administrator privileges to install Metrix. 

1. Follow these steps to start the Metrix Installer: 

• Copy the EFI Metrix Installer.dmg file to the desktop on your computer. Exact file names will vary 
based on the build number. 

Note For example, EFI Metrix 20212XXXX.dmg. 

• Double-click the EFI Metrix Installer file to open the EFI Metrix Installer disk image. 

• On the EFI Metrix Installer screen, double-click the EFI Metrix Installer.app to start the Installer. 

 

2. If an alert screen opens, click Open to continue. 
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3. On the next screen:  

• Click the Terms Of Service link and read the License Agreement. Click the Back button to return 
to this screen. 

• If you agree to the terms of the License Agreement, select the I agree to the EFI Terms Of 
Service check box. 
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4. Click Install to begin the installation process. 

 

5. On the authentication screen, enter the username and password for your system, and then click OK. 
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6. When the installation is complete, click Close. 

 

7. To set up Metrix, go to Launch Metrix and Initial Setup. 
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Launch Metrix and Initial Setup 

The Initial Setup process has changed to facilitate configuring Metrix to use SQL servers.  

1. Start eFlow License Manager if it is not already running. 

2. If you have Concurrent Licensed Metrix, start the Data Server (C:\ProgramFiles\EFI\Metrix or 
/Applications/EFI/Metrix). 

3. Double-click the Metrix application icon on your desktop. 

4. In the Metrix Initial Setup screen: 

• Provide the following setup information (the image below is from a Mac installation): 

 

Note On the right-hand side of the screen you will see red and green icons: 

 Green = OK  

 Red = Required fields 

• Locale: Accept the default English or select another language from the pull-down list. 

• MIS System: Accept the default (None) or select an MIS option from the pull-down list. 

• License Server Address: Enter the static IP address or DNS name for your eFlow License 
Manager. 

• If you are running the eFlow License Manager on the local machine, enter localhost or 
127.0.0.1. 

• If you are running the eFlow License Manager on a different machine, enter the IP 
address for that server. 

• Press the Tab or Enter key to validate the license server address 
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Notes When the connection is established, eFlow appears in the field next to the 
License Server Address field. 

 If the text “Failed to identify licensing type” appears, verify that the eFlow License 
Manager is running, the computer is connected to the network, and you have 
entered the correct license server address and port (if applicable), and then 
press Tab again. Validation of the license server IP address should take no 
longer than 5 seconds.   

 If you choose to change the default port for the eFlow License Manager, enter 
the IP address followed by a colon and the port number (e.g., 192.168.1.10:8082 
or eflow:8082). 

• Customer ID: Enter the Customer ID number provided by ePS for your Metrix license. 

Database Configuration Settings:  

• Database: Click on the Database pull-down list and choose from the options below. 

• Embedded Database 

• Metrix Database Server (hypersonic) 

• Microsoft SQL Server 

• PostgreSQL Server 

Note If you have a Single User License, you must select Embedded Database. 

  If you select either Microsoft SQL Server or PostgreSQL Server, the 
Database Name, Username, Password, and Connection Properties fields 
become available. If you select Embedded Database or Metrix Database 
Server, those fields are disabled. 

• Database Address: If you selected Metrix Database Server, enter the Database 
Server’s static IP address. If you selected either Microsoft SQL Server or PostgreSQL 
Server, enter the DNS name of the computer on which the Database Server is installed. 

Note  If your SQL configuration requires a port for the Database Server other than the 
default (1433 for Microsoft SQL Server, 6543 for PostgreSQL Server with eFlow, 
5432 for PostgreSQL Server without eFlow, 9939 for Metrix Database Server), in 
the Database Address field enter the address or DNS Name followed by a colon 
and the port number (e.g., 123.45.6.78:9999) 

• Database Name: Enter the name of your database. 

• Username: Enter your Database Server username. 

• Password: Enter your Database Server password. 

• Connection Properties: Enter any additional connection properties you want to use.  

• Measurement Units: Select an option (i.e., Inches or Millimeters) from the pull-down list. 

Note  Metrix validates the Database Configuration information when all the relevant 
fields for the selected database type have been completed. 

Note If a message appears at the top of the screen informing you that Metrix cannot 
find the database server, verify that the server is running, the computer is 
connected to the network, and you have entered the correct database server 
address and port (if applicable). Click the Database Address field, and then 
press Tab again. Validation of the database server IP address should take no 
longer than 5 seconds. 

• Click Save and Launch to open Metrix (or click Quit to close without saving), log into Metrix with 
the password that applies to your User Role  and then click OK. 

Important  Change the password to a more secure alternative when you are finished, or create 
your own user IDs and passwords in the database. 
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Login Password 

Administrator a 

Guest guest 

Senior senior 

Junior junior 

Upgrading Metrix 

Metrix 22.1 is a full install only – there is no updater. To upgrade, you need to uninstall the previous version of 
Metrix and then perform a complete reinstall. After completing the steps in this section, go to Installing Metrix.  

 (1) Shut Down the Data Server and the License Server 

Shutting down the Data Server 

Ensure that all Metrix clients are shut down. 

Metrix 2016.2 and earlier: On the Data Server computer, execute Shutdown Metrix Data Server. 

Metrix 2017.3 and later: In the Metrix Data Server window, click Shutdown.    

Important These are the only methods you should use to shut down the Data Server.  
 
If the Data Server is ever shut down abruptly (for example, with a CTRL+C in a command line in 
Windows or Force Quit in Mac OSX), some data loss may occur. 

 (2) Back up your Metrix 21.2 (and earlier) files and folders 

To preserve the Metrix database, marks, and settings, back up these Metrix folders and files found inside your 
Metrix folder, C:\ProgramData\EFI\.. An easy way to do this is to make a copy on your desktop of these folders. 

• Data folder 

• Marks folder 

• metrix.properties file (Metrix 2016.2 and earlier) 

Note Not all configurations of Metrix have all the above folders and files in the Metrix folder. If your 
Metrix folder does not contain all the above folders and files, then back up the files it does 
contain. 

(3) Uninstall Metrix 

Windows 

1. Go to the Windows Control Panel  

2. Select Uninstall a program and uninstall the EFI Metrix program. 

3. Delete the Metrix folder at C:\ProgramData\EFI\. 

Note If your ProgramData folder does not appear in your C: drive menu, follow the steps below to 
make the ProgramData folder visible: 
1. Click the Windows Start button.  
2. In the Search programs and files field, type “folder options.”  
3. Select the “Change search options for files and folders” option. 
4. Open the View tab.  
5. In the Files and Folders | Hidden files and folders section, select Show hidden files, 
folders, and drives  

6. Click Apply  

7. Click OK. 
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4. You should now be able to see the ProgramData folder on your hard drive so you can open it and 
delete the Metrix folder. 

Mac 

1. Go to Applications > EFI on your computer and drag the Metrix folder into the trash. 

Note If the Metrix shortcuts on your desktop did not disappear, drag them into the trash too. 

2. Empty the trash. 

Installing Metrix Automation Server (AS)  

Note Metrix Automation Server runs only on Windows. 

Installing Metrix Automation Server 

Before installing, close all applications and restart your computer to clear any files from memory. 

1. Copy the Metrix_AutomationServer_20221XXX.exe file to your computer. Exact file names will vary 
based on the build number. 

2. Double-click ePS Metrix Installer. 

3. If the installer requests permission to install Metrix on your computer, click Yes to begin the installation. 

4. On the welcome screen, click Next. 
 

 

5. On the License Agreement screen, read the “ePS Software End User License Agreement,” click I 
accept the terms of the license agreement, and then click Next.  

Note Click Print if you want to print a copy of the EULA for your records. 
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6. In the Setup Type screen, select the default Complete (unless you have a reason to choose Custom), 
and then click Next.  
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7. On the Ready to Install the Program screen, click Install.  
 

 

The Setup Status screen will show progress as the software is installed.  
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8. On the InstallShield Wizard Complete screen, click Finish. 
 

 

Configuring Metrix Automation Server as a Service 

Metrix Automation Server can be configured to run as a headless service for optimization. This service needs to 
be readily available and resilient, so it is recommended to deploy this application as a Windows service. 

 

Configuring Metrix Automation Server as a Service 

1. Follow the standard procedures for installing the Metrix Automation Server.  

2. Run Metrix in GUI mode and configure the application to ensure it is functioning normally.  

3. Close the application.  

4. Press the Windows key and type cmd.  

Note You can also enter cmd directly into the Windows search bar.  
 

 

5. Right-click on Command Prompt and select Run as administrator.  
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6. Execute the following commands one at a time.  

Command: cd “Program Files\EFI\MetrixAS\Service\bat” 

Note If this folder does not exist, the installed version of Automation Server does 
not support Windows service and you cannot complete the configuration.   

a. Action: Temporarily set the JAVA_HOME to Metrix Java.  

i. Command: set JAVA_HOME=“C:\Program Files\EFI\MetrixAS\JREX64” 

b. Action: Permanently add the Metrix Java to the system path.   

i. Command: setx path “%path%;C:\Program Files\EFI\MetrixAS\JREX64\bin” 

7. Install the service. 

a. Action: Install the service.  

i. Command: installService.bat 

Notes If the command does not execute the install, run setenv.bat and then run 
installService.bat again.  

  Optionally, you can run the command startService.bat. 

  Other commands include StopService.bat and UninstallService.bat. 

8. Go to Services in Windows and locate the Metrix Automation Server, or Metrix Automation Server 
Pace.  

9. Right-click and change Automatic to Automatic with delay.  

10. The first time you must start the service manually.  
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Notes To confirm the service is running go to C:\ProgramData\EFI\MetrixAS\Logs\ and try to delete 
all files. If the system returns the Unable to delete two files message, this means the service is 
running. 
 
If your server machine gets restarted, then the Metrix Automation Server service will start 
automatically.  

Upgrading Metrix Automation Server 

Metrix 22.1  Automation Server is a full install only – there is no updater. To upgrade, you need to uninstall the 
previous version of Metrix Automation Server and then perform a complete reinstall. After completing the steps in 
this section, go to Installing Metrix Automation Server.  

 (1) Shut Down Metrix Automation Server 

(2) Back up your Metrix Automation Server 21.2 (and earlier) 
metrix.properties file 

To preserve the Metrix Automation Server configuration and licensing settings, back up the metrix.properties 
file, which is in C:\ProgramData\EFI\Metrix. An easy way to do this is to make a copy on your desktop. 

(3) Uninstall Metrix Automation Server 

1. Go to the Windows Control Panel  

2. Select Uninstall a program and uninstall the EFI Metrix Automation Server program. 

3. Delete the Metrix folder at C:\ProgramData\EFI\. 

Note If your ProgramData folder does not appear in your C: drive menu, follow the steps below to 
make the ProgramData folder visible: 
1. Click the Windows Start button.  
2. In the Search programs and files field, type “folder options.”  
3. Select the “Change search options for files and folders” option. 
4. Open the View tab.  
5. In the Files and Folders | Hidden files and folders section, select Show hidden files, 
folders, and drives  

6. Click Apply  

7. Click OK. 
4. You should now be able to see the ProgramData folder on your hard drive so you can open it and 

delete the Metrix folder. 

(4) Install Metrix Automation Server 

Go to Installing Metrix Automation Server and follow the instructions. When the installation is complete, place the 
backup copy of the metrix.properties file in C:\ProgramData\EFI\MetrixAS and then launch Metrix Automation 
Server. 

 

Appendix A: Where Metrix Files Are Installed in Windows 

Metrix 22.1 for Windows has been engineered to run properly for a non-administrator user without requiring Run 
as Administrator privileges. Windows Metrix 22.1 looks for files in the ProgramData/EFI folder. 

The initial configuration of the following folders and file will be in the ProgramData/EFI folder (although some are 
user configurable and may be changed to user-specified locations):  

• Automation 

• Commands 

• Content 

• Data 
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• PreviewCache  

• PreferencesBackup 

• Imports 

• Logs 

• metrix.properties file 

Note If your ProgramData folder does not appear in your C: drive menu, follow the steps below to make the 
ProgramData folder visible: 

       1. Click the Windows Start button.  
2. In the Search programs and files field, type “folder options.”  
3. Select the Change search options for files and folders option. 
4. Open the View tab.  
5. In the Files and Folders | Hidden files and folders section, select Show hidden files, folders, and 
drives.  
6. Click Apply. 

7. Click OK. 


